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SSM. De slutsatser och synpunkter som presenteras i rapporten ar forfat-
tarens/forfattarnas och 6verensstimmer inte nédvindigtvis med SSM:s.

Bakgrund

[ ett tidigare NESC-projekt (Network for Evaluating Structural Compo-
nents — Thermal Fatigue) togs fram en Europeisk procedur fér hantering
av termisk utmattning. Den tidigare myndigheten Statens kidrnkraftinspek-
tion (SKI) var en av projektets finansidrer. Proceduren innehaller bl.a.
utvirdering av en modell for analys av hégcykelutmattning vid turbulent
termisk blandning. Modellen, som ér baserad pa en skadedatabas av tidigare
observerade termiska utmattningsfall, anvinds for att prediktera tiden till
sprickinitiering och for att ta fram sallningskriterier for temperaturskillna-
der i blandare. Proceduren tillhandahaller dock inga firdiga instruktioner
for problemlosningar pa grund av &mnets komplexitet och omfattning.

Syfte

Syftet med projektet var att ta fram ett programpaket f6r analys av termisk
utmattning baserat pa den metod som beskrivs i NESC-TF:s procedur "De-
velopment of a European Procedure for Assessment of High Cycle Thermal
Fatigue in Light Water Reactors, January 2007".

Resultat

Det utvecklade programmet kan framforallt anvindas for att 16sa problem
med turbulent blandning. Programmet utgor ett forenklat sitt att analysera
termisk utmattning och i sin nuvarande form kan inte fanga upp 3-dimen-
sionella effekter som kan vara avgorande for sprickpropagering. Program-
met kan med férdel anvindas som verktyg for kianslighetsstudier.

Effekter pa SSM:s tillsynsarbete
Programmet kommer att vara till nytta vid SSM:s sdkerhetsvarderingar av
mekaniska komponenter i svenska kiarnkraftsanldggningar.
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SSM:s projektledare: Kostas Xanthopoulos.

Diarienummer: SSM 2008/185.

Aktivitetsnummer: 2037028-05.
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INLEDNING

1.1 Bakgrund

Termisk utmattning dr en kidnd skademekanism i kiarnkraftsindustrin som traditionellt har observerats vid
blandning av vitskor av olika temperatur, till exempel nira ett T-ror eller vid ldckage av en ventil. Flera
internationella forsknings- och utvecklingsprojekt har utforts med syftet att béttre kvantifiera processen, samt att
utveckla metoder for att genomfora beddmningar av termisk utmattning.

Problemet har fatt utokat intresse i Sverige pa grund av termiska utmattningsskador som nyligen har upptéackts i
styrstavar i tva svenska kéarnkraftverk.

Med finansiering av SSM och Ringhals AB, deltog Inspecta 2007 i projektet NESC-TF (Network for Evaluation
of Structural Components — Thermal Fatigue) [ 1]. Ett huvudsyfte var utveckling av en procedur for utvardering
av hog cykel utmattningsskador orsakade av turbulent termisk belastning. Proceduren var baserad pa en
skadedatabas av tidigare observerade termiska utmattningsfall och var inriktade pa T-rér. Det noterades att
proceduren kanske dven kunde appliceras pa andra komponenter, dven da dessa inte var inom ramen for
projektet.

NESC-TF tog fram sorteringskriterier som specificerade hur en termisk utmattningsutvérdering kunde utforas
pa flera olika detaljnivaer:

Niva 1: Ett enkelt sorteringskriterium specificeras, baserat pa (nominell) AT mellan tva blandande vétskor.
Nivé 2: Amplituden av AT behovs och anvénds som indata till en analys. Spadnningar och tdjningar dr

framréknade fran en varmeoverforingsanalys. Spanningsanalysen &r elastisk med antagande av en
sinusvariation av temperaturen vid ytan av materialet.

Niva 3: Utmatningsutnyttjandegrad rdknas fram med analys av hela belastningshistorien tillsammans med
utmattningskurvor.

Niva 4: Analyserna dr baserade pa brottmekanik och handlar om berdkning av tillvéxt av sprickor.

Iden var att de mer komplexa metoderna, som krdvde mer indata, ska innehalla mindre konservatism.

1.2 Syfte

Syftet med nuvarande projekt &r att utveckla ett program paket for Niva 2, den sa kallade SIN-metoden. Modellen
kan anvéndas for att forutsiga tiden till sprickinitiering och for att ta fram screeningkriterier for temperaturskillnader
i blandare och vid ytor av stinger. Proceduren tycks vara konservativ i de flesta fall, men det skall noteras att
proceduren inte tillhandahaller ndgra fardiga instruktioner fo6r problemldsningen pé grund av &mnets komplexitet och
omfattning.
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2 METOD

2.1 Overblick

En termisk utmattningsutvirdering bestéar av fo6ljande steg (som specificeras i T-Utm enlig Figur 1):
Definiera komponentgeometri, samt termisk belastning (avsnitt 2.2)

Definiera utmattningsegenskaper (avsnitt 2.3)

Definiera termiska, samt mekaniska, materialegenskaper (avsnitt 2.4)

4. Uppskattning av tid till sprickinitiering (avsnitt 2.5).

el

) Define material parameters

File Help
— Geometry — hiaterial Parameters
Geometry type Internally loaded pips " .
s | ! AR | Elastic mudulusepa
. Poisson's ratio
Internal radius 200 | rmrm
. i 7800 "
External radius 220| mm Density kgfmd

Heat transfer
coefficient

30000 | Wirnaa e Thermal conductivity 17.2 | Wim K

— Fatigue Properties Specific heat 533 kikg K

Fatigue curve
Mean curve - Austenitic 55, Alloy 600, Alloy EEDD.bd| Thermal expansion coefficient|  1.802e-005| /i

Load ] [ Preview l

Plasticity [,
correction

m 0.351

I

A 712 MPa

Fatigue reduction

factor kKf 123

Figur 1 Sidan som anvandas for att specifiera indata till en analys.

T-Utm producerar en ’Fatigue vs Temperature Reference Curve’, baserad pa SIN- metoden [ 1]. Ett exempel pa
analys resultaten visas i Figur 2. Fran kurvan tillats en utvirdering av tid till sprickinitiering for en utvald

nominell temperaturvariation (AT).
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Figur 2 Exempel av en ‘Fatigue vs temperature reference curve’

2.2 Geometri och termisk belastning

Som forsta steg 1 SIN- metoden definieras komponent geometrin samt den termisk belastningen. Det finns tvé
alternativ i T-Utm som illustreras i Figur 3:

a) Ett ror med uniform intern termisk belastning. Temperaturen vid ytan varieras med tid enlig en
SIN funktion men ar konstant i axiell- samt omkretsriktning. En adiabatisk randvillkor antas pa
utsidan av roret.

b) En sting med uniform extern termisk belastning. Temperaturen vid ytan varieras med tid enlig en
SIN funktion men &r konstant i axiell- samt omkretsriktning.

+
Ty ¥
AT : AT -
— AT AT
! .

Cyelic temperature field applied
around the outer edge of 1

Cyclic temperature field applied
around the inner edge of the pipe

Figur 3 De tva geometrier, samt belastningsscenarior, som tillats av T-Utm. (a) Ett rér med en uniform
intern termisk belastning, (b) En stdng med uniform extern termisk belastning.

Ett virmedvergangstal méste specificeras. Se avsnitt 8.2.2 frdn NESC-TF slutrapporten [ 1] for rdd om
specificering av /.
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2.3 Utmattningsegenskaper

Anvindaren har val av flera utmattningskurvor som técker flera typ av material, inklusive austenitiska rostfria
stél, Ni-Cr-Fe legeringar, kol stal och ’low alloy’ stdl. Kurvorna har tagits fran tvé kéllor: Argonne National
Laboratory [ 4] och, som ett alternativ, Jaske och O’Donnell [ 2]. Ett exempel av en utmattningskurva syns i
Figur 4.

) View fatigue curve

Mean curve - Austenitic SS, Alloy 600, Alloy 800

[&)]

-
o

—

________ {}""""E_Youngs Modujlus:195 GPa

-
o
.
T

-
o

w

o

Allowable fictitious stress amplitude (MPa)

Cycles to failure

Figur 4 Exempel av en utmattningskurva som laddas i T-Utm.

Anvéndaren méste gora foljande gillande utmattningsegenskaper:
1. Specificera typ av material,

2. Vilj mellan en *design’ eller 'mean’ kurva, vilket dr en beddmning som anvidndaren méste gora.
’Designkurvan’ kan vara en naturlig kandidat for komponent design och *meankurvan’ kan vara en
naturlig kandidat for utvérdering av komponenter under drift.

3. Om ’designkurva’ véljs, vdlj kurvan som técker rétt ‘mean stress’,

Om "meankurva’ viljs, bestdm om en plasticitetskorrigering bor anviandas och specificera
korrigeringsparametrarna.

5. Specificera en anvisningsfaktor som tar hénsyn till utmattningsfaktorer som ér ’komponentspecifika’
utdver sjilva utmattningskurvorna.

Tabell 1 listar utmattningskurvorna fran Jaske och O’Donnell [ 2]. Design kurvorna &r baserade pa 2:20
faktorerna tillimpade pé spédnningsamplitud och antal cykler pa samma sitt som adopterats av ASME (den
faktor som dr mest konservativ ar faktorn som tillimpas). Konceptet ar illustrerat i Figur 5 [ 2].
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B M (a) Types 304, 310, 316, 387 and 348 at 21 to 427 € (70 10 BOD F} [Refa. 4, 7, 10, 1215, 77, sad 21)
— Axial strain contrel, 0 = 0

© [a} Type 304 annesled bar xt 21 C {70 F} [Ref, 25} = Axial losd control, 0, = O

a {al Type 304 annealed bar at 427 C {800 F] {Ref. 25} — Axial load control, o = 0

+ {al  Type 347 anncaled bar at 316 C {600 F) (Rel. 26} — Axial losd control, o, = O

4 {b) Type 316 snnealed bar a1 21 C (70 F} (Ref. 20t — Axisl lond control at 14,5 kHz, ap, = 0

Notes: (a) lIncluded in regremion anmlysi,
(5} Not includad in regression wnalysit.

Mean curve: § = 8,081,000/+/N + 31,580

2
o
o E= 26,3 x 10° pii
s
[ -
]
10%|—
i~ Design curve
T T T AN S RNl AR ANl B S E 1 i
° 10t 10° 03 104 10® 10¢ 107 10

Number of Cycles

Figur 5 lllustrering av 2:20 regeln fér austenistiska rostfria stal [ 2] dar 'mean curve’ modifieras med
en faktor 2 pa spanning och 20 pa antal cykler for att ta fram en ’design curve’ (indikerad).

Tabell 2 listar utmattningskurvorna fran Argonne National Laboratory [ 4] som dr inprogrammerade i T-Utm.
Data ér baserade pa tdjningsstyrd provning. Kurvorna presenteras dock som S, vs N, dir referens
elasticitetsmodul som anvéinds for att rdkna S, &r listad med kurvan (se t.ex Figur 1). Design kurvorna ér
baserade pa 2:12 faktorerna tillimpade pa spanningsamplitud och antal cykler (den faktor som &r mest
konservativ ar faktorn som tillimpas).

Tabell 1 Utmattningskurvor som ar inbyggda i T-Utm mjukvaran som publicerades av
Jaske och O’'Donnell [ 2]. Data galler for temperaturer mellan 20°C till 427°C, férutom Alloy
600 dar det galler 20 °C till 316 °C.

Material Mean utmattningskurva Design utmattningskurvor

Austenitiisk rostfritt stél Ja Ja — kurvor som motsvara en mean stress’

304, 310, 316, 347, 348 upp till 303MPa

Ni-Fe-Cr legering 800 Ja Ja — kurvor som motsvara en ’mean stress’
upp till 303MPa

Ni-Cr-Fe legering 600 Ja Ja — kurvor som motsvara en 'mean stress’
upp till 303MPa

Ni-Cr legering 718 Ja Ja — kurvor som motsvara en *max stress’ over

en cykel upp till 1010MPa
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Tabell 2 Utmattningskurvor som ar inbyggda i T-Utm mjukvaran och som publicerades av
Argonne National Laboratory [ 4]. Data galler i luftmiljé for temperaturer mellan 20°C och
371°C.

Material Mean utmattningskurvor | Design utmattningskurva

Austenitisk rostfria stal av Ja Ja —"mean stress’ effekter

typ 304, 316, 304L, 316L tas hansyn till

och 316NG

Ni-Fe-Cr legeringar av typ Ja Ja —"mean stress’ effekter

600 och 690 tas hansyn till

Ni-Fe-Cr svets legeringar Ja Ja —"mean stress’ effekter

av typ 152, 82, 182 och tas hansyn till

132

Kol stél Ja Ja — “mean stress’ effekter
tas hansyn till

’Low alloy’ stél Ja Ja —’mean stress’ effekter
tas hansyn till

Plasticitetskorrigering, som rekommenderas att anvinda under analys, baseras pa foljande modell av den
cykliska spannings-tojnings kurvan.
1

Ao (Ao \m
Ag(%)=100— +| — 2.1
om0t (22) o

déar Ae, Ao och E dr respektive tojningsrackvidd (%), spanningsrackvidd (MPa) och elasticitetsmodul. A4 och m
ar materialparametrar. Ekvation (2.1) anvénds for att justera spdnningsnivan orsakad av plasticering. Enligt
NESC-TF rapporten[ 1], avsnitt 9.3.1, typiska vérden for austenitiskt rostfritt stal 4r 4 =712MPa och m=0.351.
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2.4 Termiska och mekaniska materialegenskaper

Materialegenskaper som specificeras ér listade i Tabell 3.

Tabell 3 Materialegenskaper, bade termiska och mekaniska, som definieras inom
T-Utm mjukvaran.

Parameter Beteckning | Miétenhet | Kommentarer

Elasticitetsmodul E GPa Definieras for genomsnittlig
vétsketemperatur. En typisk
vérde for austenitiskt rostfritt stél
vid drift &r 184GPa.

Poissons tal v ~ Definieras for genomsnittlig
vitsketemperatur. Ett typiskt
vérde for austenitiskt rostfritt stél
vid drift &r 0.3.

Densitet Yol kg/m’ Definieras for genomsnittlig
vitsketemperatur. Ett typiskt
vérde for austenitiskt rostfritt stél
vid drift dr 7800.

Virmeledningstal y) W/m.K | Definieras for genomsnittlig
vitsketemperatur. Ett typiskt
vérde for austenitiskt rostfritt stél
vid drift ar 17.2.

Specifikvidrme (68 kJ/kg.K | Definieras for genomsnittlig
vitsketemperatur. Ett typiskt
vérde for austenitiskt rostfritt stal
vid drift ar 533.

Utvidgningskoefficient a W/m’ K | Definieras for genomsnittlig
vitsketemperatur. Ett typiskt
vérde for austenitiskt rostfritt stl
vid drift &r 18-10°,

2.5 Uppskattning av tid till sprickinitiering
Anvindaren kan vilja mellan tva olika analyssétt nar det giller uppskattning av tid till sprickinitiering:
1. Uppskatta tid till sprickinitiering som en funktion av AT for en bestdmd frekvens.
2. Uppskatta tid till sprickinitiering som en funktion av AT och frekvens, pa sa sitt att minsta tid till
sprickinitiering uppskattas.
Analys som baseras pa en bestdmd frekvens bestér av foljande steg:

1. Termisk analys. Detta gérs med hjilp av en 1D, finit element modell dér 16sningen &r gjord i
frekvensdoménen. Pa en sida av komponenten appliceras en sinus-varierande last och pa den andra
antas virmeodverforing som adiabatisk. Temperaturféltet som uppskattas anvénds sedan som indata till
spanningsanalysen.

2. Spinningsanalys. I spdnningsanalysen antas en generaliserad plan tojning i axiell led, dvs axial
kraften &r lika med noll. Darfor berdknas spanningskomponenter med:
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Spanningen ges 1 form av en frekvensresponsfunktion, FRT, dvs varje komponent (c,,6,,6.) har en
komplex form. Ur dessa komponenter bildas en komplex Tresca-spanning dér absolutvirdet ar
amplituden S,

O-a = O-tresca (2'3)
3. Lastamplitudskorrigering
Spénningsamplituden korrigeras enligt,
EC
AC, » =0, E K, K, (2.4)

dér E och E, ar elasticitetsmodul for material respektive elasticitetsmodul vid temperatur tagen fran
utmattningskurvan. K, dr en ’fatigue strength reduction factor’ som specificeras av anvéndaren for att
ta hénsyn till ’lkomponentspecifika’ detaljer som kan minska tiden till sprickinitiering. K, ar en
"plastic strain amplification’ [ 3] som beriknas automatiskt nér plastisk korrigering specificeras av
anvandaren.

4. Utvirdera tid till sprick initiering. Den tidigare utvalda utmattningskurvan anvéndas tillsammans
med resultaten fran Ekvation (2.4) for att berdkna antal cykler till sprickinitiering. Tid till
sprickinitiering berdknas med hjélp av belastningsfrekvenser.

5. Repetera for alla AT. Punkt 1-4 repeteras for alla AT som &r relevanta till analysen for att definiera
tid till sprickinitiering som funktion av AT (visas i Figur 2).

Uppskattningen av minimal tid till sprickinitiering som funktion av frekvens och AT (analyssétt 2) baseras pé
samma metod med skillnaden att en optimeringsprocedur anvinds for att bestimma frekvens som ger minimal
tid till sprickinitiering (se avsnitt 8.2.11 [ 1] ).

2.6 Tolkning av resultaten for T-ror forband — 80% regeln

Referenskurvorna for utmattningslivslangd tillater anviandaren att uppskatta tiden till sprickinitiering for ett
givet AT. Vid analys av ett T-ror kan anvéndaren vélja att applicera 80% regeln, dvs en reduktion av nominella
temperaturer fran 100% till 80% vid den lokala analysen. Detta dr en tumregel som baseras pa observerade
lokala temperaturvariationer pa 80% eller mindre av nominell AT [ 1].
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3 ANALYS MED T-UTM

T-Utm har tre huvudfonster:
1. Analysfonstret, didr en analys specificeras och kors.

2. Indatafonstret, dir analysparametrar relaterade till geometrin, utmattningsegenskaper och material
egenskaper, specificeras och redigeras.

3. Resultatfonstret, dir resultat frén fler analyser laddas och jamfors.

3.1 Analysfonster

> Analysfonstret’ dr forsta fonstret som oppnas nar T-Utm startas av anvdndaren. Dess utseende visas i Figur 6.

J Tutm - thermal fatigue analysis software E@§|

File Analysis Results Help

— Joh files

Results file name AustSSPipeh15000.utm
Input file name StandardinputPipe-h15000 tin

— Analysis options

Analysis type |Fixed frequency analysis v

Freguency [0.25 Hz

Run analysis

Figur 6 Utseende av 'analysfonstret’.

3.1.1 Specificera analysfiler samt utfora en analys

En termisk utmattningsanalys gors enligt foljande steg:

1. Fiéltet Results file name’ anvinds for att specificera namnet pa filen dér analysresultaten kommer att
sparas. Anvénd 'Browse’ knappen for att bliddra igenom och hitta rétt fil.

2. Filtet ’Input file name’ anvinds for att specificera namnet pa indatafilen som innehaller
analysparametrar enligt avsnitt 2. Denna indatafil maste sparas i forvig enligt avsnitt 3.2. Anvind
’Browse’ knappen for att bldddra igenom mappar och hitta rétt filer som har sparats tidigare.

3. Fdéiltet *Analysis type’ anvénds for att vélja analyssétt. Dar finns tva val, *Critical frequency analysis
— minimum time to failure’ och ’Fixed frequncy analysis’, som diskuterades i
avsnitt 2.5. Om "Fixed frequency analysis’ véljs, specificera da dven analysfrekvensen i *Frequency’
faltet.

4. Filtet ’Run analysis’ anvénds for att kora igdng en analys. Som alternativ anvinds menyvalet
>Analysis=> Run analysis'.

3.1.2 Tillgang till andra delar av programmet

Fran *analysfonstret’ dr det mojligt att fa tillgéng till de andra delarna av programmet:
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1. Menyvalet *File->Define new input file’ anvinds for att definiera nya indataparametrar och spara
dessaien ’.tin’ fil.

Menyvalet *File>Edit existing input file’ anvinds for att redigera en existerande indatafil.
3. Menyvalet ’Results> View results file’ anvinds for att titta pa analysresultat.
4. Menyvalet "Help>Manual’ anvénds for att fa tillgang till hjélpfiler (denna rapport).

3.2 Indatafonster

Indatafonstret, som illustreras i Figur 7, anvénds for att definiera nya analysparametrar, samt att redigera
existerande analysparametrar. Foljande parametrar kan specificeras eller dndras:

1. Geometriska parametrar, inklusive typ av geometri, relevanta radier och virmedvergéngstal.

2. Utmattningsegenskaper, inklusive utmattningskurva, plasticitetskorrigeringsval, och ’fatigue
strength reduction factor’.

3. Materialparametrar, som inkluderar alla de parametrar som listas i Tabell 3.

J Define analysis parameters

Internal radius 50| e

External radius 70| mm

Heat transfer

coefficient 13000 Wi/ 2k

— Fatigue Properties

Fatigue cure
Mean curve - Austenitic S5, Alloy 600, Alloy 300 ixt

Load l l Preview l
Plasticity (o, K.
correction
m 0.351
A 12| MPa
Fatigue reduction
125

factor Kr

Density

Therrmal conductivity

Specific heat

Thermal expansion coefficient

Filz  Help
— Geametty — Material Parameters
Geometry type Internally loaded pips w .
yiye Elastic modulus 184 |GPa
Poisson's ratio 03

7800 kyfm~3

17.2| Wi,k

533 klkg.K

1.802e-005 | ji<

Figur 7 Utseende av 'indatafonstret’.

Det dr mojligt att granska utvald geometri och utvald utmattningskurva med relevanta ’Preview’ knappar.

Indatafiler laddas och sparas enligt f6ljande menyval:

1. Menyvalet File>Open input file’ anvinds for att dppna och redigera en existerande indata fil.
2. Menyvalet *File>Save as’ anvinds antingen for att spara en ny indata fil eller for att spara dndringar i

en existerande indatafil.

SSM 2010:47

11 (20)




3.3 Resultatfonster

Resultatfonstret illustreras i Figur 8 och anvénds for att analysera, jamfora och exportera resultaten fran
termiska utmattningsanalyser. Det &r mojligt att jamfora flera analysresultat samtidigt i fall man vill gora
parameterstudier. Det dr ocksd mojligt att exportera resultaten for att utféra parameterstudier i en annan
mjukvara, till exempel MS Excel.

} Review results

EoX

Fil= Data Settings Results Help
Fatigue life vs temperature reference curve
80 percent rule has been applied
180 *J T T I
+  AustSSPipeh30000

=] IS A A + AustSSP!peh'lSOOO i
g D ; ; +  AustSSPipeh10000
e * N Fitted equation
R A promrrmmmmeme prerrmm P ]
2 e | i i
< . A I I I |
< A | ] ]
o : ; ; ;
s b * : ; ;
L 100 - Plpoeee Foees R R IERECREED Proooseessoosesooos .
£ %+ ; : :
£ Co o T e : :
[ B P R A T
£ . B A I S SO S
=] : T * o :
Z B0 s **‘*-1&*-;;:.iis4j+tiﬁt* -------- .

40 | | : :

10" 10° 10° 10° 10° 10"
Time to crack initiation (hours)

Figur 8 Utseende av 'resultatfonstret’ nar tiden till sprickinitiering plottas som funktion av nominell

temperaturskillnad.

Resultatfiler kan 1dggas till eller tas bort med hjilp av f6ljande menyval:
1. Menyvalet "Data=> Add data file’ anvinds for att ladda och plotta resultaten fran en ytterligare

resultatfil.

2. Menyvalet "Data=>Remove data file’ anvinds for att stinga en datafil.

Parametrar som tidigare anvints under analys kan granskas med hjilp av menyvalet:

’File> View analysis parameters’.

Axlarna kan justeras med hjilp av menyvalet:

’Settings—> Axis properties’.

Det finns flera olika val for vilka resultat som kommer att plottas:

1. Menyvalet ’Results=>Fatigue temperature reference curve-> View’ plottar tid till sprickinitiering

som funktion av nominell temperaturskillnad (Figur 8).

2. Menyvalet > Results = Frequency versus temperature curve-> View’ plottar analysfrekvens mot tid till
sprickinitiering. Kritiska frekvenser kommer att visas i de fall d en minimum tid till sprickinitiering har

analyserats (Figur 9).
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} Review results EJIEI @I

File Data Settings Results Help
Loading frequencies used for calculation
80 percent rule has been applied
'1 4 T T T T I I
; ; ; ; +  AustSSPipeh30000
| RO SO AU S +  AustSSPipeh15000 ||
' ; +  AustSSPipeh10000
— *i E E
k- SR S — .
)
T 1 T g S S S S -
3 *
o
£
L2 B e e e e CELEELEEEELEEE  CREEECREEEEEE -
£ *
o
@
0 ST A S S I SR 4
+ , +
0.2 o Frrmmeeeeee U S b #]
Lt Lo+ * *
ﬁ + * & ¥ * i * !
0 NEE. +4 | | | |
40 60 80 100 120 140 160 180
Nominal temperature difference (K)

Figur 9 Utseende av 'resultatfonstret’ nar frekvensen plottas som en funktion av nominell
temperaturskillnaden. | de analysfall som visas, har kritiska frekvenser vid sprickinitiering
uppskattats.

3.3.1 Plott av tid till sprickinitiering vs nominell temperaturskillnad

Man kan analysera tid till sprickinitiering vs nominell temperaturskillnad pa flera olika sétt:

1. Menyvalet ’Results->Fatigue temperature reference curve>Export to file’ sparar plottdata till en
>.csv’ fil.

2. Menyvalet ’Results>Fatigue temperature reference curve—>80% rule’ ger anvindaren
information om 80%-regeln &r applicerad eller inte.

3. Menyvalet ’Results>Fatigue temperature reference curve>Fit equation’ gor en
ekvationsanpassning till en vald kurva fran plotten (Figur 10).

4. Menyvalet ’Results> Fatigue temperature reference curve—> Look up data’ tillter anviandaren att
interpolera fran resultaten genom att specificera antingen en tid till sprickinitiering eller en nominell
temperaturskillnad (Figur 11).
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Figur 10 Utskrift efter ekvationsanpassning till resultatdata.

Figur 11 Exempel pa interpolering av resultaten.

3.3.2 Plott av belastningsfrekvens vs nominell temperaturskillnad.

Man kan exportera plottdata fran belastningsfrekvens vs nominell temperaturskillnad pa foljande satt:

e Menyvalet Results>Frequency vs Temperature curve=>Export data’.
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4  TILLAMPNINGSEXEMPEL

4.1 Inverkan av belastningsfrekvensen

Vid en studie undersoktes belastningsfrekvensens inverkan pa tid till (och temperatur vid) sprick initiering.
Material och utmattningsegenskaper specificerades enlig Figur 12 och Figur 13. Egenskaper ar representativa
for ett austenitiskt rostfritt stal av typ 304. Det ska noteras att en "'mean’ utmattningskurva anviandes. Geometrin
specificerades som ett ror med inre belastning. ’Fixed frequency’ analyser utfordes vid frekvenser av 0.01,
0.03, 0.1, 0.3, 1.0 och 3.0Hz.

— Geometry — Material Parameters
Geametry type Internally loaded pipe v )
ylyp v PR Elastic modulus 184 | 5Pa
. FPoisson's ratio 0.3
Internal radius 1365
T iy
External radius 1615 mm Density 7300 kg/m'3
Heat transfer L
Thermal conductivit 172 Wi K
coefficient 13000 WhmA2k y
— Fatigue Properties Specific heat 533 | kdikg. K
Fatigue curve
Mean curve - Austentic S5, Alloy 600, Alloy 300 txt Thermal expansion coeficient| 1.802e-005| /i
— Analysis details
Flasticity [, K Analysis file name
correction MESC-c1-GeomD-0_1.utm
T 0.351 .
Analysis type v Fleraf
Fixed frequency analysis A
A 712 1Pa HUENEY anaty undersoks
Fatigue reduction Frzeuemey
factor Ki 125

Figur 12 Parametrar som anvands i parameterstudien. Flera frekvenser undersokts.

Resultaten frén studien visas i Figur 14. Dér finns en komplex relation mellan nominell temperaturskillnad, tid
till sprickinitiering och belastningsfrekvens. Med hjélp av interpoleringsfunktionen i menyn i resultatfonstret
(’Results>Fatigue temperature reference curve>Look up data’) 4r det mojligt att fa ut data fran
programmet och plotta resultaten som de ser ut i Figur 15. Plotten visar hur minimum nominell
temperaturskillnad varierar med frekvensen for olika tider till sprickinitiering. En léngre tid till sprickinitiering
ger bade en mindre minimum temperaturskillnad vid initiering och en mindre kritisk belastningsfrekvens.
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Mean curve - Austenitic SS, Alloy 600, Alloy 800

___________________

________ P

Allowable fictitious stress amplitude (MPa)

_______________________________

_______________________________________________

Youngs Modulus:195 GPa

Cycles to failure

Figur 13 Utmatningskurvan som anvadades i parameterstudien.

Fatigue life vs temperature reference curve
80 percent rule has been applied

700 T T I I
+ NESC-c1-GeomD-f0 3 0.03Hz
= - L L + NESC-c1-GeomD-f0, ¥0. 1Hz
S + NESC-c1-GeomD-f0, #70.3Hz
c
O ST U NESC-c1-GeomD-f1 1.0Hz
% NESC-c1-GeomD-f3 3.0Hz
o NESC-c1-GeomD-f0, 1 #-0.01Hz
=3 ! T
T 400 oo e S S .
I} *
g 5
L300 I e Y UM - S — .
T ; i i
c ' '
S 200 T e e S R .
5 MELTLL 5
100 | | i | *
10° 10° 10* 10° 10° 10"°

Time to crack initiation (hours)

Figur 14 Resulterande tid till sprickinitiering som funktion av nominell temperaturskillnad.
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Figur 15 Nominell temperatur vid sprickinitiering som funktion av belastningsfrekvensen. Resultaten
visas for flera olika tider till sprickinitiering.
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DISKUSSION

T-Utm utgdr ett forenklat sétt att analysera termisk utmattning som &r ett mycket komplext problem. Programmet ar
giltigt framforallt for problem med turbulent blandning. Resultaten ska tolkas med forsiktighet. Erfarenheten fran
NESC-TF visar att 3D- eftekter ar avgorande for sprickpropagering, vilket T-Utm inte kan fdnga upp i dess
nuvarande status. T-Utm bor dock kunna vara ett anvéndbart verktyg for att studera inverkan av olika parametrar.
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